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Start in the “Initialize” tab. Follow the step-by-step

| N Itlal VA S instructions in order to enable the macros and full
functionality of PAWQCC.

Al B i D
1
2 Probabilistic Ambient Water Quality Criteria Calculator (PAWQCC)
3 Version Beta.4
4
2
5] Initialize This Workbook on First Use (Steps 1 through 5)
The Probabilistic Ambient Water Quality Criteria Calculator (FAWQCC) uses simple Visual Basic commands in Excel to format the desired output of the probablistic modeling for evaluating
PAWQC. In order to enable this functionality, the workbook must be set up on your computer appropriately.
T Please follow the instructions below, and THEN click the button in Step 4 below.
B
9 To Share This Werkbook: UN-Initialize (Step 6)
The Probabilistic Ambient Water Quality Criteria Calculator (FAWQCC) uses simple Visual Basic commands in Excel to format the desired output of the probablistic modeling for evaluating
PAWQC. In order to share this file and maintain this functionality, the workbook must be set up on the users computer appropriately.
10 Please UN-Initialize this workbook before sharing with other users.
11
12 1| Do NOT launch @RISK.
13 2 Place this workbook in a "Trusted Location" for Excel, OR click on "Enable Content” along the yellow tab (example shown below).
i Home Insert Page Layout Farmulas Data Review View Developer Add
3 & cut Arial Y Ay == 3 [SiwepTes
Paste  fFormatpainter | B £ U~ [ HE~ DA EEE EE HMerged Center -
Clipboard Font Alignment )
E,} Security Warning  Macros have been dlsaleable Conten;)
14
15 3 i Allow Excel to Trust access to the VB project object model. Click on the "Developer” Tab. In the "Code” Group, Click on "Macro Security”
Home Insert Page Layout Formulas Data Review View Developer If you do not have the Developer Tab:
= bl B = & A peomartiae [ 1. Click the File tab and then click Options.

4 4 » M| Initialize F‘.ead EW Calculator MM&E’ Histograms Curmlatrue Prob Intercalcs .~ Bins .~ Toxicity Bioconcentration Input Results Details D
Ready | = [
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The “Introduction” tab provides a general overview of the

| ntrOd UCtiOn purpose of PAWQCC. It also provides an inventory of all

18 tabs included within the workbook.

= N L3 M=
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11

12
13
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Probabilistic Ambient Water Quality Criteria Calculator (PAWQCC)

Version Beta.4

Summary

The Probabilistic Ambient Water Quality Criteria Calculator (PAWQCC) uses the fundamental equations employed by the United States Environmental Protection Agency
(EPA) to derive ambient water quality criteria (AWQC). In addition to the parameters explicitly listed in the EPA equations, the PAWQCC software also includes implicit
parameters that affect the outcome of the equations but are not listed specifically in the equations (e.qg., exposure duration, loss of chemicals from fish tissue during cooking,
fraction of fish consumed that are caught within the state, fraction of fish consumed that reside within the water body for their entire life cycle).

The equation used in the probabilistic approach is a *forward” risk equation; that is, the equation estimates risk from a chemical concentration, exposure dose, and toxicity. This
is the reverse of the more familiar "rearranged"” equation used for the deterministic calculation of risk-based AWQC from a target risk level, exposure dose, and toxicity. The
reasons for using the forward equation for probabilistic assessments are mathematically complex and are described in greater detail elsewhere (e g., Burmaster et al. 1995,
Ferson 1998). In essence, the forward equation will yield a distribution of risks dependent on several inputs that are also distributions. If the equation is “rearranged” to solve for
one of the inputs, the resulting distribution and the original input distribution may have similar means, but the spread of the distributions will be different. Because it is the tails of
a distribution that are typically of interest for calculating acceptable risk or acceptable media concentrations, this disparity has marked effects on the outcome of the calculation.
Therefore, EPA recommends using forward equations when conducting probabilistic assessments to avoid the mathematical limitations associated with back-calculation (EPA
2001).

The PAWQCC software uses @Risk (Palisade Corporation}, a probabilistic add-on program for Excel. The user must have @Risk installed on their computer and must be
familiar with the basic functions of @Risk to define input parameters as distributions. With three exceptions, the user may enter any or all input parameters as either point
estimates or distributions. The three exceptions, which may only be entered as point estimates, are the chemical concentration in water, the target risk level, and species-
specific fish consumption rates, which are expressed as a proportion of the total fish consumption rate. The total fish consumption rate may be entered either as a point
estimate or as a distribution.

When deriving AWQC using the probabilistic approach, point estimates or distributions for the input parameters will be combined to estimate potential risk. For probabilistic
derivation, the process of estimating risk by selecting from the input point estimates or distributions will be repeated until the number of desired iterations (e.g., 10,000
iterations) is complete. One complete set of iterations is called a simulation. As long as one or more of the input parameters are distributions, the final output of a simulation will
be a distribution of risks associated with a particular concentration of a chemical in water. The user will select the percentile of the distribution of risk {or statistical
representation of the distribution) required to meet that State's particular target allowable risk level and determine whether the estimate of risk at that percentile meets the

14 State's tarnet rick rennirements
M A4 F M Introduction ATERRIER Calcuktor A3 WAnVANEVANRTIPA"" Histograms Cumulative Prob Intercalcs . Bins . Toxicity Bioconcentration Input Results Details |
Ready | = |
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The “Read Me” tab provides detailed, step-by-step

Read Me instructions for using PAWQCC. It also provides definitions

for all inputs and outputs within PAWQCC.

AlB C D E F G
1 Follow the instructions below to calculate human health risk-based ambient water quality criteria (AWQC).
i The F'rubabil@stic Ar_nbien_t Water Quality Criteria Calcu_latur (PAWQCC) rquires access FD @RISK to I:I.er.ive_ probabilistic AWQC. please be sureyou have
3 PAWQCC will function without @RISK, but the user will only be able to derive AWQC using the deterministic approach. INITIALIZED this workbook
. . o . . . . . . before using forthe firsttime.
5 All pframeters .may.f be deﬁmid _as point estimates or distributions, with the following exceptions (which may only be defined as point estimates): Please followfheintructions inthe
6 Concentration _m water '_I“' Initialize tab of thisworkbook.
i Target percentiles and risk thresholds
8 Species consumption rate (FCR:)
9 Return Links:
10 ’_1_|
11 Define general exposure parameters Section 1
In section [1], define all general exposure parameters, including drinking water intake (D), exposure duration (ED), bodyweight (BV), and carcinogenic averaging
12 time (AT.). By definition, non-carcinogenic averaging time (AT,:) is equal to ED. This cell will automatically populate itself when the user defines ED.
13 Section 1 inputs
14 Drinking water intake (Dl Liday): The volume of water consumed each day that is assumed to have the same chemical concentration as the ambient surface water. o
15 Exposure duration (ED. years): The length of time over which exposure occurs. ED
16 Body weight (BW. kg): Body weight of the exposed person. BwW
Aweraging time . non-carcinogenic (AT, years): Used to calculate the average daily intake. For non-carcinogenic effects, intakes are calculated by averaging over
the period of exposure. Therefore, for non-carcinogenic effects, AT, is by definition equal to ED, and the two parameters cancel out. Although ED and AT, could Al
17 technically be dropped from the calculation of non-carcinogenic hazards for this reason, they are included in PAWQCC for the sake of completeness.
Averaging time. carcinogenic (AT.. years): Used to calculate the average lifetime daily intake. For carcinogenic effects, intakes are calculated by averaging over a AT.
18 lifetime. T
19
20 2
21 Define fish intake parameters Section 2
In section [2], use the drop-down menu to select the fish consumption rate(s) [FCR(s)] available for input. User may choose to define either a single generic FCR or
22 multiple species-specific FCRs.
a. [Ifuser chooses to define a generic FCR, all fish intake parameters must also be generic and will be defined within the ‘Calculator’ tab. Fish intake parameters
23 include FCR, catch location factor (CLF), life history factor (LHF), proportion lipid, and bioconcentration factor (BCF).
24 b. Ifuser chooses to define species-specific FCRs, all fish intake parameters will be defined within the subsequent blue tabs: 'FCR', 'CLF, 'LHF', "Lipid’. and 'BCF".
i.  Starting in the 'FCR' tab, first define the fish species and their trophic levels in section [A]. User must define the trophic level of each species only if trophic level-
specific information is going to be used for any of the other fish intake parameters (i.e., CLF, LHF, proportion lipid, and BCF). Mext, define the total fish consumption ~
rate (FCR) and species-specific fish consumption rates (FCR:), as a proportion of the total FCR. in section [B]. The sum of the individual FCR; values may not FLR tap
wemnd 1 fia ANN0L ~f thin tatal FEDL _Llear mame dofins EC0D far um tn tnm cnnsine

a1 = ~
4 4 » o TR P A e el Read Me - Calculator  AEVPARPAN VAP Histograms -~ Cumulative Prob Intercalcs .~ Bins .~ Toxicty .~ Bioconcentration Input Results  Defais . Data

Ready | (3 |
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The “Calculator” tab is where most, if not all, of the inputs

CaICU IatOr are defined and also where results are displayed. It is

broken up into seven sections.

B C D E F €] H | J K L W M 0]
1
2 Probabilistic Ambient Water Quality Criteria Calculator (PAWQCC)
3 To derive probabilistic AWQC, define inputs and click the "Run Simulation to Calculate Risk' button at the bottom of this page.
4 PAWQCC reguires access to @RISK to derive probabilistic AWQC.
5 FAWQCC will function without @RISK, but the user will only be able to derive AWQC using the deterministic approach.
]
[ Equations:
8 Noncarcinogenic effects HI = Cy X {{{RBAy, x DI) + (RBA; X Z(FCR x CLF X LHF x BCFypyq % Lipid) x (1 - CL))) x ED) / (BW x AT, x RSC x RfD)
9 Carcinogenic effects (non-linear) ELCR = Cy x ({{RBAy, x DI) + (RBA; x 3 (FCR x CLF x LHF x BCFypy x Lipid) x (1 - CL))) x ED) / (BW x AT, x RSC x (PODIUF}}
10 Carcinogenic effects (linear) ELCR= Cy X {{({RBAy, x DI) + (RBA; X Z(FCR x CLF X LHF x BCFypyq % Lipid) x (1 - CL))) x ED x CSF) / (BW x AT;}
11
12 Light blue shaded cells require input from the user.
13
14 Gray shaded cells will automatically populate based on blue cell inputs.
15 Cells with underlined text, including section numbers, contain hyperlinks.
16
17 All parameters may be defined as point estimates or distributions, with the following exceptions {(which may only be defined as point estimates).
18 Concentration in water (C,)
19 Target percentiles and risk thresholds
20 Species consumption rate (FCR:)
21
22 1 !
23 General exposure parameters
24 Define parameters below.
25
26 DI ED BW AT.. AT,
drinking water . . averaging time aweraging time
27 intake eupasure duration bady weight (nen-cancer] ioanoe]
28 LIdzw YEars kg YESIE JEars
29
30
E| 2 !
32 Fish intake parameters
33 Select the fish consumption rate (FCR) available for input.
34
s [ ]
36
ar
_38

My e e L e, Calculator AP ARTVATTIANTEIWA Histograms - Cumulatie Prob Intercalcs - Bins . Toxicty .~ Bioconcentration Input Results  Defails . Da
Ready | 23 |
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i Section 1 is where the user enters general exposure
SeCthn 1 parameters. These include drinking water intake,
exposure duration, body weight, and averaging time.

| 1 |
General exposure parameters
Define parameters below.

DI ED BW Alne AT.
drlnl.cclng W aker ewposure duration bady weight averaging time averaging time
intake [ron-cancer] [cancer]
Liday e ars kg LEears Ve ars

=Y
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i Section 2 is where the user enters fish intake parameters.
SeCtlon 2 PAWQCC gives the user the option of defining either
generic or species-specific fish consumption rates.

2]

Fish intake parameters
Select the fish consumption rate (FCR) available for input.

-

| generic

speciesspedific _ ____ Mfine fish intake parameters below.

available?
FCR CLF LHF Lipid
fish cn:;zmptmn catch location factor| life history factor fraction lipid
: : kg lipid/
f
kg/day unitless unitless kq tissue

7 14 April 2014 © 2013 ARCADIS g::"‘ A RCAD l S



Section 3

Section 3 is where the user enters chemical-specific

parameters. The user may use drop-down menus to select

from a list of chemicals for which default bioconcentration
and toxicity factors are available within PAWQCC.

30

Chemical-specific parameters
Define chemicals and associated parameters below.
Use buttons to look up default bioconcentration and toxicity factors.

RBA., ne RBA., - RBA; . RBA: . CL SC BCFipiq BCFiiceye
relative relative relative relative lipid-bazed tizsue-base
. noncarcinogenic Larcinogenic bicavailability of | bicavailability of bicawailability of ) - . relative source P . .
chemicalname . . . bioavailabilicy of cooking loss T bioconcentration | bioconcentrat
health endpoint | health endpoint water, water, fizh, ) ) . contribution
) ) ) ) . .| fizh, zarsinogenic factar factar
nancarcinogenic carcinogenic noncarcinogenic
unitless unitles=s unitless unitless unitless unitless Likg lipid Likg tissue
! Look Up EPA
- BCF
1.11-Trichloroethane -
11.2.2-Tetrachloroethane nical Look Up EPA
1.1.2-Trichloroethane BCF >
1.1-Dichloroethens
1,2 4.5-Tetrachlorobenzens =
1.24-Trichlorobenzene Look Up ERA
1.2-Dicklarabenzens BCF -
12-Oichlorosthans S
Look Up EPA
BCF =
Look Up EPA
BCF =
Look Up EPA
BCF =
Look Up EPA
BCF =
Look Up EPA
BCF =
Look Up EPA
BCF =
Look Up EPA
BCF =
Hote:
Green font = the user has ent
Red font = text has been ente
41
Riclk thrachnldc
- M Introduction _« Read Me JEe=MIEI @ FCR o CLF « LHF ¢ Lipid « BCE 400 SIGdol e Cumulative Prob Intercalcs . Bins .~ Toxicity .~ Bioconcentration Input Results  Details |
;| & |
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i Section 4 is where the user defines risk management
SeCthn 4 thresholds. The user may select target risk thresholds for
the mean of the population as well as up to three

percentiles. The user may also define deterministic risk

thresholds in order to derive deterministic criteria in

Section 5.

Risk thresholds
Define up to three target percentiles between 0 and 100 below. Targets must be point estimates.

30

! Define target risk thresholds below. Thresholds must be point estimates.

Hliarget ELCRiarget
target hazard target excess
! index lifetime cancer risk
unitless unitless

! deteministic

! arithmetic mean

A0tk percentile

T

9 14 April 2014 © 2013 ARCADIS g'ﬁ-: ARCADIS



Section 5

10

14 April 2014

Section 5 calculates AWQC using the traditional
deterministic approach. If the user has entered point
estimates for all inputs and defined deterministic risk

thresholds in Section 4, deterministic AWQC will be
calculated automatically in Section 5.

5]

Deterministic approach: solve for water concentration to derive AVWQC
Water concentration is calculated below.

ConCEntration in COnCEntration in
. water, waker,
chemical name . . . .
noncarcinogenic carcinogenic
endpoint endpoint
mail mafl

© 2013 ARCADIS
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. Section 6 is where the user will calculate AWQC using the
SeCthn 6 probabilistic approach. This approach uses the “forward”
risk equation, meaning the user will enter a water

concentration and the result will be a distribution of

potential risk.

Probabilistic approach: sobe for target risk to derve AWAIC
Darfine wiaaler conceniration balow, Deterministic hazard andior

Conoenlration miis] be a poinl estimale. risk is calculated bilow, Probabdistic kagard is caloukaled bilow. Probabalistic risk is cabculated balo.
L Hlee ELCHm Hlmpar, Higy Hige Hips ELCRongan ELCHy, ELCRps ELCRGy
deieiminis =1 mothmesin mean Ash vk
" b pancan e
o deteministic sucesz lisims Erthmess mean ek i I I A listi=—= sucent llelm
B Coneeri@ion in Fumcr i e | Fuscr o indme; hazsnd e X

ehemicd fane ) ez ik eanes dak S il k

e rarutl=an wriilexn rrutlean unide s unidleax Lriilesn wrnllean Lridexs unitlez writhesn
Tangiet Ht Taeget ELCR:

mgil

|
|
|
|
|
|
|
|
|
|

] e ] el ] e ] e ]
] ] ] — f— — f— — f— f—
Sy SESSS hy SSSS— SSSSS. jy SSSSS ) SSSS j) Suuw ) SuSmm, j Sum- | s=——
p— — — — — — — — — —
e e B s e B e s B e B e B s B e
] e ] | ] | e |— —o |—
] ] f— f— f— — f— — f— f—

I I |
I I |
I I |
I I |
I I |
I I |
I I |
I I |
I I |
I I I

Hate:

Green shading & calcubted hazand or nsk does not excesd wer-defined tanget level
alow shading = caloulaled RArard of risk axceeds uber-defined 1argel Eoel
Al calcwlnted hazerds and nsics sre rounded 1o two signaficant figeres before comparson bo tangsd kevels
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Section 7

Section 7 is where the user will choose the number of
Monte Carlo iterations to run and then click the “Run
Simulation” button.

T

Run simulation

Humber of lterations:

Run Simulation to

Calculate Risk
=00
Pleaze be sure vou have initialized this workboak before using for the first time.
Please follow the intructions in the Initialize tab of this workboolk.,
12 14 April 2014 © 2013 ARCADIS ‘:’f‘ A RC AD ' S



Section 6;

Evaluate Results

After the simulation is complete, evaluate the results

In Section 6. If the resulting risk distribution meets the
risk management criteria, the water concentration

may be used as the AWQC. If not, iteratively adjust
the water concentration until the resulting risk

distribution meets the risk management criteria.

8]

Probabilistic approach: solve for target risk to derive AWQC
Define water concentration below.

Concentration must be a point estimate.

chemical name

Cu

CORCEntration in
water

mall
| PCEs | 8.976E-08 |
| Heptachlar | 1.103E-07 |
Butylberzyl | |
| phthalate AT
13 14 April 2014

Deterministic hazard andior
risk is calculated below.

Hlget

deterministic
hazard index

ELCRyet
deterministic
enoess lifetime
cancer risk

unitless unitless
TargetHl: Target ELCH:
1 1.0E-06
| | 1.4E-06 |
| | 1.4E-08 |
| 0.683133464 | |
Hote:

Probabilistic pazard is calculated ;lelow.

Hlpean Hlpg Hlg» Hlpa
arithmetic mes J0ch percentile
hazard index| hazard index
unitless unitless unitless unitless
TargetHI: Target HI: TargetHI:
1 1
| 0.5021093348 | 0.3373465871 |

L

Green shading = calculated hazard or risk does not exceed user-defined target level

Yellow shading = calculated hazard or risk exceeds user-defined target level.

All calculated hazards and risks are rounded to two significant figures before comparison to target levels.

© 2013 ARCADIS

Probabilistic risk is calculated belol'.l.

ELCRpean ELCRp4 ELCR.» ELCRy3
arithmetic mean J0th percentile
enoess lifetime encess lifetime
cancer risk cancer risk
unitless unitless unitless unitless
Target ELCR: Target ELCR: Target ELCR:
1.0E-06 1.0E-05
| 1.0E-06 | 2.3E-06 |
| 1.0E-06 | 2.3E-06 |

¢ ARCADIS



The “Histograms” and “Cumulative Prob” tabs provide

PIOtS histograms and cumulative probability plots of the
resulting risk distributions.

Cancer Endpoint

PCBs | ELCR

0.16

014
— PCBs | ELCR

] mean 1.0E-06
90th percentile 2 3E-06

012

[=]
=

Pro bability
. =]

(=)

La

2.0E-08
2.9E-08
4. 2E-068

Cancer Endpoint

PCBs | ELCR
1
/’_’—_

03

03 // PCBs | ELCR

a7 / mean 1.0E-06
£ 08 90th percentile 2 3E-06
ﬁ a5 /
B . /

g Bp2eEg@gE5E5EBELELE &8 88 8 28 88 8 8

T T R B R S R R BT T S SV /R T/ ST

I s - B R T - - B S R T B s B B

Mo = ol — = rMomo o o o = Mmoo P o e
ELCR
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Input Results

The “Input Results” tab provides snapshots of input
distributions as well as summary statistics.

Mame Cell Graph Min Mean Max 5% 95%:: Errors
v v

drinking water intake C29 0.002447518 1.729691 8.970859 0.35125815 3.789966 0
v -

fish consumption rate C43 0.000556064 0.024043638 0.5353403 0.003156312 0.07441738 0
-;'_ _'_'.'

body weight E29 44.02193 80,49844 200.8354 52,3589 117.8904 0
0. 1000 0.040
v L

fraction lipid F43 I I 0.004043333 0.01714495 0.03593238 0.00765359186 0.03363821 0
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The “Details” tab provides additional detailed statistics for
all resulting risk distributions. The “Data” tab provides all
individual risk results calculated for each iteration of the

Detalls, Data

simulation.
Mame PCBs | HI PCBs | ELCR Heptachlor | HI Heptachlor | ELCR Butylbenzyl phthalate | HI iE
Description Output Output Output Output Output C
Cell Calculator!F132 Calculator!G132 Calculator!F134 Calculator!G134 Calculator!F13& C
Minimurm nfa 1.9E-08 nfa 1.4E-08 0,008329991 n
Madimum nfa 2,3E-05 nfa 2,3E-05 3.856514 n
Mean nfa 1.0E-06 nfa 1.0E-06 0,5021093 n
Std Deviation nfa 1.49E-06 nfa 1.49E-06 0,5595345 n
Variance nfa 2.07334E-12 nfa 2.04305E-12 0.3130789 i
Skewness nfa 4,939529 nfa 4,996923 4,755264 n
Kurtasis nfa 43,45834 nja 43.42631 40, 59643 r
Errors 5000 ] 5000 ] ] <
Mode nfa 2.0E-07 nfa 2.7E07 0.2610363 r
5% Perc nfa 9,8E-08 nfa 1.0E-0F 0,105301 n
10%s Perc nfa 1.5E-07 nja 1.5E-07 0.1396006 n
15%: Perc nfa 1.9e-07 n/a 1.9E-07 0.1640425 r
20%: Perc nfa 2.3E-07 nfa 24607 0,.1897751 r
25% Perc nfa 2, 7E-07 nfa 2.8E-07 0,2113796 n
30% Perc nfa 3, 2E-07 nfa 3.3E-07 0,2343182 n
35% Perc nfa 3.T7EO7 n/a 3.8E-07 0.2591672 r
40%: Perc nfa 4,3E-07 nfa 4,3E-07 0,233195 n
45% Perc nfa 5.0E-07 nfa 5.0E-07 0.3101472 r
50% Perc nfa 5, 7E-07 nfa 5. 7E-0F 0,339001 n
16 14 April 2014 © 2013 ARCADIS gf‘ A RC A D I S



e INnt

alcs: Intermediat culations supporting the

culator” tab. Used(for species-specific fish -

ake calculations.

e Bins: Intermediate;,ﬁ; alculatj.? used to build
“histograms and cumulative probability plots.

* Toxicity: Default toxicity factors that are retrieved

by look-up buttons. |
* Bioconcentration: Default USEPA _

“bioconcentrat ctors that rleved by look-

‘up buttons.
I

W
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the result

Ine

Imag
\



